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  General Controls and Display
Availability of Menus in Cisco UC Integration for Microsoft Lync

Cisco UC Integration for Microsoft Lync can operate in two modes, as follows:

• Integrated with Microsoft Lync or Microsoft Office Communicator: The Cisco UC pane is located 
at the bottom of the Microsoft Lync or Microsoft Office Communicator window.

• Not integrated with Microsoft Lync or Microsoft Office Communicator: The Cisco UC pane runs 
independently of Microsoft Lync or Microsoft Office Communicator, and is displayed in a separate 
window.

Cisco UC Pane Integrated with Microsoft Lync or Microsoft Office Communicator

The following table describes how to access the menus that are available when the Cisco UC pane is 
integrated with Microsoft Lync or Microsoft Office Communicator:

Cisco UC Pane Not Integrated with Microsoft Lync or Microsoft Office Communicator

The following table describes how to access the menus that are available when the Cisco UC pane runs 
independently and is not integrated with Microsoft Lync or Microsoft Office Communicator:

Operation Menu Text Keyboard Shortcut 

Open the Microsoft Lync Tools menu. Select the Show menu arrow 
next to the Options button 

 in the Microsoft Lync 
window, then select Tools.

When the focus is in 
Microsoft Lync, but not in the 
Cisco UC pane, press Tab to 
move input focus to the 
Options button, then press 
Spacebar. Then use the 
arrow keys to move focus to 
the Tools menu.

Open the Microsoft Office 
Communicator Tools menu.

Select the Menu button  in 
the title bar, then select Tools.

When the focus is in 
Microsoft Office 
Communicator, but not in the 
Cisco UC pane, press Alt, 
then use the arrow keys to 
move focus to the Tools 
menu.

Open the conversations window menu. Select the Menu button  in 
the conversations window title 
bar.

When the focus is in the 
conversations window, press 
F10.

Operation Menu Text Keyboard Shortcut 

Open the Cisco UC pane menu. Select the Options button 
 in the Cisco UC pane.

When the focus is in the 
Cisco UC pane, press Tab to 
move input focus to the 
Options button, then press 
Spacebar or Return.

Open the conversations window menu. Select the Menu button  in 
the conversations window title 
bar.

When the focus is in the 
conversations window, press 
F10.
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  General Controls and Display
Setting Input Indicators for the Display

Cisco UC Integration for Microsoft Lync displays input indicators to assist users who have difficulty 
seeing objects on the screen. Input indicators are dotted rectangles around objects that show which 
screen object currently has focus. To display input indicators all of the time, perform the steps that are 
appropriate for your operating system, as described in the following table.

Moving the Input Focus Between Microsoft Lync or Microsoft Office 
Communicator and the Cisco UC Pane

Modifying Your Cisco UC Pane Options

Operating System Procedure

Windows XP 1. Open the Control Panel and select Display.

2. Select the Appearance tab.

3. Select Effects.

4. Uncheck Hide underlined letters for keyboard navigation until I 
press the Alt key.

Windows Vista
Windows 7

1. Open the Control Panel.

2. Select Ease of Access > Ease of Access Center > Make the keyboard 
easier to use.

3. Check Underline keyboard shortcuts and access keys.

Operation Menu Text Keyboard Shortcut 

Move the input focus from 
Microsoft Lync or Microsoft Office 
Communicator to the Cisco UC pane.

Not applicable Press Alt-Tab and continue 
to hold the Alt key and press 
Tab to select the Cisco UC 
pane.

Move the input focus from the 
Cisco UC pane to Microsoft Lync or 
Microsoft Office Communicator.

Not applicable Press Alt-Tab and continue 
to hold the Alt key and press 
Tab to select Microsoft Lync 
or Microsoft Office 
Communicator.

Operation Menu Text Keyboard Shortcut 

Open the Cisco UC Options dialog 
box.

File > Options Move the input focus to the 
Cisco UC pane, then press 
Ctrl-Shift-P.
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  Phone Management
Phone Management
• Switching Phone Modes and Selecting Your Phone Device, page 4

• Viewing Your Conversation History, page 4

Switching Phone Modes and Selecting Your Phone Device

Viewing Your Conversation History

Operation Menu Text Keyboard Shortcut 

Set the Cisco UC pane to work with 
your desk phone or the phone on your 
computer.

Actions > Switch Phone Mode Move the input focus to the 
Cisco UC pane, then press 
Ctrl-Shift-T.

If you are using your desk phone for 
calls, select which phone to use with 
the Cisco UC pane.

Actions > Select Phone Move the input focus to the 
Cisco UC pane, then press 
Ctrl-Shift-S.

Operation Menu Text Keyboard Shortcut 

Open the Conversation History dialog 
box.

Actions > Open Conversation 
History

Move the input focus to the 
Cisco UC pane, then press 
Ctrl-Shift-F3.

Navigate around the Conversation 
History dialog box.

Not applicable Tab

Move the input focus to the next entry 
in the conversation history.

Not applicable Down Arrow

Move the input focus to the previous 
entry in the conversation history.

Not applicable Up Arrow

Open the shortcut menu for a 
conversation history entry.

Right-click on the entry. Shift-F10

Delete an entry from the conversation 
history.

Right-click on the entry, then 
select Delete.

Delete
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  Placing and Answering Calls
Placing and Answering Calls
• Placing a Call, page 5

• Answering a Call, page 5

Placing a Call

You can also place a call from the Conversation History dialog box, by opening the shortcut menu for a 
conversation history entry. For more information, see Viewing Your Conversation History, page 4.

Answering a Call 

Note You might need to request your Cisco Unified Communications system administrator to increase the 
number of rings or the duration allowed for an incoming call before it is redirected to voicemail.

Operation Menu Text Keyboard Shortcut 

Open the keypad to dial a number. Actions > Open Dialpad/Close 
Dialpad

Move the input focus to the 
Cisco UC pane, then press 
Ctrl-D.

Operation Menu Text Keyboard Shortcut 

Switch the focus to the incoming call 
notification window.

Not applicable Ctrl-Shift-G

Answer a call with audio only. Not applicable Ctrl-Shift-A

Answer a call with audio and video. Not applicable Ctrl-Shift-V

Forward a call to your voice message 
service.

Not applicable Ctrl-Shift-M
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  Working with Conversations
Working with Conversations
The keyboard shortcuts described in the table below apply to both phone calls and conference calls, when 
the conversations window is the active window. The keyboard shortcuts apply to the currently-selected 
conversation in the conversations window. All of the menu items listed in this section are available both 
when Cisco UC Integration for Microsoft Lync is integrated with Microsoft Lync or Microsoft Office 
Communicator, and not integrated with Microsoft Lync or Microsoft Office Communicator. 

Operation Menu Text Keyboard Shortcut

Open the menu in the conversations 
window.

Select the Menu button  in 
the conversations window title 
bar.

F10. 

You can use the arrow keys to 
navigate the menu.

Note When you press F10, 
you can also open the 
submenus and select 
options by pressing 
the letters on the 
keyboard that are 
underlined for each 
submenu and option. 
For example, press 
F10, c, k to open the 
Conversations 
submenu and select 
Open Keypad.

Close the conversations window. File > Close Alt-F4

Move the input focus to the next active 
call in the conversations window.

Not applicable Down Arrow

Move the input focus to the previous 
active call in the conversations 
window.

Not applicable Up Arrow

Move the input focus to the first active 
call in the conversations window.

Not applicable Home

Move the input focus to the last active 
call in the conversations window.

Not applicable End

Move the input focus to another active 
call in the conversations window, 
when a conference call is selected.

Not applicable Ensure that the participant 
list does not have input focus. 
If it does, press Tab to move 
input focus to the conference 
call. Then use the Up Arrow 
and Down Arrow keys, or the 
Home and End keys to move 
the input focus.

Open or close a keypad to enter 
numbers or characters in the active 
call.

Conversation > Open 
Keypad/Close Keypad

Ctrl-K
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  Working with Conversations
Increase the volume at which you 
receive audio on the active call.

This feature only works when you are 
using the phone on your computer for 
calls.

Conversation > Volume Up F9

Decrease the volume at which you 
receive audio.

This feature only works when you are 
using the phone on your computer for 
calls.

Conversation > Volume Down F8

Set your microphone to mute, or 
switch mute mode off.

This feature only works when you are 
using the phone on your computer for 
calls.

Conversation > Mute 
Microphone

F7

Open the Select Contacts dialog box to 
select a contact to transfer the active 
call to.

Conversation > Transfer To > 
Contact

Ctrl-F

Complete the transfer of a call to a 
contact that you have selected.

Conversation > Complete 
Transfer

Ctrl-Shift-F

Put the active call on hold, or resume a 
call that is on hold.

Conversation > Hold 
Call/Resume Call

Ctrl-H

Add video to a call. Conversation > Add Video to 
Call

Alt-Shift-V

Remove video from a call. Conversation > Remove Video 
from Call

Alt-Shift-V

Temporarily stop or resume sending 
video with the active call. 

Conversation > Mute Video Ctrl-F7

Display the video in full screen mode. Not applicable Alt-Shift-F

Restore the display of video to the size 
of the conversations window.

Not applicable Esc

Start an instant message conference 
with the person you are calling.

Conversation > Start an Instant 
Message Conference

Ctrl-Shift-3

Start a meeting and invite all 
participants on the active call.

Conversation > Start a 
Meeting

Ctrl-Shift-5

Park the active call. Conversation > Park Call Ctrl-P

Hold or resume the active call. Conversation > Hold Call Ctrl-H

End the active call. Conversation > End Call Ctrl-E

Operation Menu Text Keyboard Shortcut
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  Working with Conference Calls
Working with Conference Calls
These keyboard shortcuts apply to conference calls only, when the conversations window is the active 
window. The menu items listed in this section are available both when Cisco UC Integration for 
Microsoft Lync is integrated with Microsoft Lync or Microsoft Office Communicator, and not integrated 
with Microsoft Lync or Microsoft Office Communicator.

Operation Menu Text Keyboard Shortcut

Open or close the list of participants in 
a conference call.

Conversation > Open 
Participant List/Close 
Participant List

Ctrl-L

Move the input focus from the 
participants list to the conference call 
and vice versa.

Not applicable Tab

Move the input focus to the next 
participant in the participants list.

Not applicable Down Arrow

Move the input focus to the previous 
participant in the participants list.

Not applicable Up Arrow

Move the input focus to the first 
participant in the participants list.

Not applicable Home

Move the input focus to the last 
participant in the participants list.

Not applicable End

Open the Select Contacts dialog box to 
select participants to add to the active 
conference call.

Conversation > Conference 
With > Contact

Ctrl-M

If you have two active calls, merge the 
calls into a conference call.

Note This keyboard shortcut only 
works when you have two 
active calls, giving you a 
conference call with three 
participants, including you. If 
you want more participants, 
you can call the next 
participant, then merge the call 
into your conference call.

Not applicable Ctrl-Shift-M

Open the context menu for a 
participant in a conference call.

Not applicable Select the participant, then 
press Shift-F10, or the 
Application key.

Place a call to a participant before 
adding them to a conference call.

Participant > Place a Call > 
<default-number-for-the-
participant>

or

Place a Call > 
<default-number-for-the-
participant>

Select the participant, then 
press Ctrl-1.
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  Working with Voicemail
Working with Voicemail
You can listen to your voice messages in one of the following ways:

• Audio voicemail: Places a call to your audio voice message service.

• Visual voicemail: Opens a window that displays a visual representation of your voice messages.

You select which voicemail format you want to use in the General tab of the Cisco UC Options dialog 
box. For more information about how to open the Cisco UC Options dialog box, see Viewing Your 
Conversation History, page 4.

For information about how to open a keypad to enter numbers or characters during the active call, see 
Working with Conversations, page 6.

Open the Microsoft Lync or 
Microsoft Office Communicator 
instant message window to send an 
instant message to the selected 
conference call participant.

Participant > Send an Instant 
Message

Ctrl-3

Open the Microsoft Lync or 
Microsoft Office Communicator 
instant message window to send an 
instant message to all participants in a 
conference call.

Not applicable Ctrl-Shift-3

Display the contact card for the 
selected conference call participant.

Participant > View Contact 
Card

Alt-Enter 

Add the selected participant to a 
conference call.

Participant > Join to 
Conference

Select the participant, then 
press Ctrl-Shift-J.

Removes the selected participant from 
a conference call.

Participant > Remove from 
Conference

Select the participant, then 
press Ctrl-Shift-R.

Operation Menu Text Keyboard Shortcut

Operation Menu Text Keyboard Shortcut 

Call your voice message service.

(If Call my voicemail service is 
selected in the General tab of the Cisco 
UC Options dialog box.)

Actions > Call Voicemail Move the input focus to the 
Cisco UC pane, then press 
Ctrl-Shift-F4.

Open a window that displays a visual 
representation of your voice messages.

(If Open the conversation history to 
show my voice messages is selected in 
the General tab of the Cisco UC 
Options dialog box.)

Actions > Open Voicemail 
History

Move the input focus to the 
Cisco UC pane, then press 
Ctrl-Shift-F4.

Play or pause the selected visual 
voicemail message.

Not applicable Ctrl-P

Rewind the visual voicemail message 
by a predefined time interval.

Not applicable Ctrl-B
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  Viewing the Online Help
Viewing the Online Help
The menu item listed in this section is available both when Cisco UC Integration for Microsoft Lync is 
integrated with Microsoft Lync or Microsoft Office Communicator, and not integrated with 
Microsoft Lync or Microsoft Office Communicator.

Important Notes
• Screen readers do not announce the descriptive label for the phone handset icon that is located under 

the buttons on the Cisco UC pane. The descriptive label is: “To place a call, drag and drop contacts 
on this area.” Instead, the screen readers announce this icon as “Button.”

• Screen readers do not announce the action that is taken when you move the input focus to the 
Cisco UC pane, then press Ctrl-Shift-T. This action sets the Cisco UC pane to work with either the 
desk phone, or to use the computer for phone calls.

• It can be difficult to read Cisco UC Integration for Microsoft Lync windows with the high contrast 
appearance scheme High Contrast #1.

• You cannot use the keyboard to perform the following actions:

– Expand or collapse the Cisco UC pane

– Resize the Cisco UC pane in the Microsoft Lync or Microsoft Office Communicator window

– Resize columns

– Sort list items

Fast forward the visual voicemail 
message by a predefined time interval.

Not applicable Ctrl-F

Stop listening to the visual voicemail 
message.

Not applicable Ctrl-S

Increase the playback volume for 
listening to visual voicemail 
messages.

Not applicable F9

Decrease the playback volume for 
listening to visual voicemail 
messages.

Not applicable F8

Stop listening to the visual voicemail 
message, and remove the message 
from your cache of voice messages.

Not applicable Ctrl-Shift-X

Operation Menu Text Keyboard Shortcut 

Operation Menu Text Keyboard Shortcut 

Open the online help. Help > Help Topics F1
10
Accessibility Features in Cisco UC Integration for Microsoft Lync Release 8.5

 



 

  Getting More Information About Accessibility and This Product
Getting More Information About Accessibility and This 
Product

For more information about the accessibility of this product, see the Voluntary Product Accessibility 
Template (VPAT) for this product. The VPAT lists the requirements needed for this product to conform 
to Section 508 of the U.S. Rehabilitation Act.

You can get the VPAT at the following URL:

http://www.cisco.com/web/about/responsibility/accessibility/legal_regulatory/vpats.html

Alternatively, contact the Cisco accessibility team at accessibility@cisco.com. 

Cisco and the Cisco logo are trademarks or registered trademarks of Cisco and/or its affiliates in the U.S. and other countries. To view a list of 
Cisco trademarks, go to this URL: www.cisco.com/go/trademarks. Third-party trademarks mentioned are the property of their respective owners. The 
use of the word partner does not imply a partnership relationship between Cisco and any other company. (1110R)

Any Internet Protocol (IP) addresses used in this document are not intended to be actual addresses. Any examples, command display output, and 
figures included in the document are shown for illustrative purposes only. Any use of actual IP addresses in illustrative content is unintentional and 
coincidental.

© 2010 Cisco Systems, Inc. All rights reserved.
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  Getting More Information About Accessibility and This Product
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